BATTLEGROUND: ARDENNES Readme


VERSION 1.33  4/97


Added Next Stack hot key CTRL-X.


Fix for Windows 95 white hex outline problem.


Added Extreme Fog-Of-War Optional Rule (no melee odds, no strength points


  for units in non-clear, non-smoke, non-fort hexes, and no morale).


Added red-highlighting of strength value of units not at full strength.


Change so that only External Passengers are visible to other side when


  Extreme FOW is in effect.


Added network play capability.


Fixed the Windows 95 white hex-outline problem.


New Accelerator key "Ctrl-X" moves the Hot Spot to the Next Stack.


Added an Extreme Fog-Of-War optional rule, which when in effect (note: 


normal FOW must also be in effect) hides units' morale, melee odds, the 


Strength Points (SP) of units in non-clear (including smoke and 


fortification) hexes, and the passengers of transport vehicles (but not 


those riding "externally" on tanks and other such armored vehicles).


When a unit drops below full strength, its SP number in the Unit List 


turns from black to red.


TCP/IP INTERNET PLAY 


Internet play is now supported. Prior to beginning TCP/IP Internet play, 


both players should ensure that they have a valid TCP/IP connection 


established on their computers. Typically this is a service of your Internet 


Service Provider.


1. Select "Modem Host" or "Modem Caller" from the Menu screen.


2. Select "Internet Connection".


3. The Modem Host should select a new scenario or resume a previously saved 


   game. The Modem Caller should select the corresponding module for the 


   chosen scenario or battle.


4. A dialog on the Modem Host system will appear, containing the Internet 


   address for the Modem Host. Note: Typically this address is changed by 


   your Internet Service Provider each time an Internet Connection is 


   established.


5. The Modem Host should then provide the Caller with this address. This 


   can be done by calling the Caller on a separate line, by sending the 


   address through E-Mail, or by using an Internet "chat" program. The 


   Modem Caller will then type this address into his Internet connection 


   dialog. He can also specify an encryption key at this time. He should 


   then choose Connect on the Connection dialog.


6. At this point, both players will have a Communication Dialog, and play 


   will start or continue similar to standard Dial Up Modem Play (see 


   section 7.1 in the Players Guide).


Added an "Internet Connection" menu item to the Special Menu. Normally you 


will initiate Internet play after choosing either "Modem Host" or "Modem 


Caller" from the main Menu Screen. However, if you wish to initiate it from 


within the main program, you should select the "Internet Connection" menu 


item prior to selecting "Modem Host" or "Modem Caller" in the Special Menu.


VERSION 1.32  2/97


Fixed incorrect Major Victory VP total in scenario 20 "The Tables Turned" 


(dec20all.scn).


Corrected playing of bazooka video when 60mm mortars are fired.


Reduced the use of smoke by the A/I.


When FOW is in effect, *all* Improved Positions, Fortifications and 


Minefields are now hidden. They are revealed when within the LOS of a 


friendly unit in the same manner as if they were enemy units [Exception: 


no "?" (Unknown-Unit) marker appears when a unit is adjacent to them; they 


appear automatically whenever their hex is entered].


Added an "Initial View" item to the Options Menu. The Initial View menu 


item is used to define the initial view of the map shown when the main 


program is started. This may be set to any of the standard 2D or 3D map 


views, or it may be set so that it is always the view that existed when 


the program was last closed.


Added a "Rules..." button in the A/I Selection Dialog. Selecting this button 


allows the player to use one or both of the following optional rules:


INDIRECT FIRE BY THE MAP: This option allows indirect-fire (only) weapons of 


both sides to attack any hex on the map (within range, but regardless of 


LOS). To fire by the map, simply right-click on the target hex as if firing 


normally.


	If the target hex is in the LOS of a friendly (to the firer) unit 


and contains one or more visible enemy units, the normally applicable attack 


strength is used. If the target hex is in the LOS of a friendly unit but 


contains no visible enemy unit, the normally applicable attack strength is 


halved. If the target hex is not in the LOS of a friendly (to the firer) 


unit and contains no visible enemy unit, the normally applicable attack 


strength is quartered.


	The firing player will not receive a fire-effect report if the 


target hex contains no visible enemy unit. The enemy player will receive a 


fire-effect report in two-player hot-seat and play be e-mail.


DIGGING-IN CAPABILITY: This option allows non-vehicular units to create 


Improved Positions during play. To have a unit attempt to dig in, Select it 


during its Movement Phase, then Select the Toggle Digging-In item in the 


Units Menu. If the unit is able to begin digging in, the "wheel" icon in its 


data area in the Unit List will change to the "improved position" icon. 


	A unit cannot attempt to dig in if it is disrupted, vehicular, has 


fired in the preceding Prep Fire Phase, and/or has already conducted an 


activity in the current Movement Phase. Digging in is prohibited in a hex 


that already contains an Improved Position or a Fortification.


	A unit digging in cannot move or engage in any other movement-related 


activity, has its attack strength (H# and S#) halved, cannot initiate an 


assault, and counter-assaults at half of its otherwise-applicable strength. 


A hidden unit digging in within enemy LOS is significantly more likely to 


be revealed.


	If a unit becomes disrupted or retreats while digging in, its 


digging-in status is immediately lost. A player can voluntarily cancel his 


unit's digging-in status during any friendly phase by Selecting first the 


unit and then the Toggle Digging-In menu item.


VERSION 1.31 1/97


Fixed corruption of battle file caused by choosing "Cancel" in Two-Player 


Hot-Seat Replay option.


Fixed PBEM replay bug that caused crashes and hangs due to inadvertant 


word-wrap in .bte file.


VERSION 1.3  9/96


SPECIAL OPTIONS: Clicking on this new menu-screen button lets you start 


(or resume) a game using either Play by E-Mail (PBEM) or Hotseat with Fog 


of War.


HOTSEAT WITH FOG OF WAR: This "Special Options" choice allows two players 


to play a scenario using the same computer, with Fog of War in effect. When 


one player has finished making his moves and/or attacks, the program draws 


a blank map for the start of the next phase and informs him that it is now 


his opponent's turn to move or attack.


VICTORY POINTS: VPs are now deducted per Strength Point (SP) lost. Unit VPs, 


objective VPs and scenario VP levels have been recalculated accordingly. A 


unit's "VP" number in the Unit List now represents its *per-SP* value. To 


find the unit's total VP value, multiply its VP number by its current number 


of SPs.


	The new method of calculating unit VPs makes the per-SP value of 


some weak units higher than that of more powerful units - but to view this 


as meaning the weak unit is "worth more" than the strong one is comparing 


apples and oranges. Each full-strength platoon's VP total is divided by the 


number of SPs it contains to arrive at its per-SP value, so one with only 


two SPs will tend to have a higher per-SP value than one with six SPs even 


though the latter will have a higher overall VP value.


ASSAULT PHASE: When a hex becomes devoid of defending units as the result 


of an Offensive Fire Phase attack, it becomes a Vacant Hex. (A red triangle 


icon appears in the hex to mark it as such.) A Vacant Hex may be assaulted 


during the next Assault Phase, and the assaulting unit(s) will automatically 


occupy the hex.


Added bazooka video and sound effects.


Improved the AI targeting algorithm.


Added an Air Power reminder to the Command Report.


All units have their movement allowance halved while they are disrupted. 


Their Unit List entry shows this halved allowance.


The red firing line does not appear if the firing unit's hex is not spotted.


When a unit fires, its facing on the 3D map changes so that it faces its 


target.


The Artillery Dialog now uses shorter unit names so that the hex coordinates 


are always visible.


Right-clicking in the Unit List changes the current terrain picture to a 


diagrammatical display of the Hot Spot hex's hexside terrain.


Fixed crash caused by airstrikes.


Fixed bug that sometimes allowed trucks to spot for firing smoke.


INDIRECT-FIRE CLARIFICATION: An indirect-fire attack is applied against 


each unit in the target hex. In addition, each target unit's Strength 


Points (SPs) are multiplied by the applicable nominal attack factor and 


the result is then divided by 5 to find the effective attack factor vs. 


that unit. (In other words, effective AF = [nominal AF# * SP#] / 5)


	For example, a target unit of 5 SPs will have the nominal AF 


applied to it. A target unit of 2 SPs will have 2/5 of the AF applied to 


it. The rationale for this calculation is that the indirect-fire results 


against a single target unit of, e.g., 4 SPs should be the same as the 


total indirect-fire results against two target units of 2 SPs in the same 


hex. The calculation will apply the indirect AF against target units 


proportional to their SPs, thus resulting in a total combat result 


comparable to firing at a single unit of the same total strength.


VERSION 1.2  4/96


PLAY BY E-MAIL: The menu screen now offers a "play by e-mail" (PBEM) option. 


To start a PBEM game, Select the button for this option, and Select whether 


or not you are starting a new scenario. Next you choose the scenario. When 


the map appears, choose the local side (i.e., the side you will play) and 


whether or not Fog of War will be used. You can also set the Advantage (see 


below) at this point. Then Select "OK", and proceed with play. When the 


Defensive Fire Phase begins, you will get a message that local control is 


over. You will be prompted to save the game (note that it must retain a 


".bte" extension) and e-mail the saved-game file to your opponent.


	To resume the game on his end, the opponent downloads the file into 


the subdirectory that contains the map used by that scenario. He then 


double-clicks on the BATTLEGROUND: ARDENNES main program icon, Selects the 


PBEM option, and answers "No" to the question of whether he is starting a 


new PBEM game. He then Selects the appropriate Map Set and saved-game file, 


and Selects "OK". At this point an automatic "Replay" option to see the 


other player's most recent moves/attacks is presented. After the replay is 


finished (or if the player chooses not to view it), the next phase begins 


and play resumes. At the end of local control, a prompt to e-mail the file 


will appear.


	The same procedure is followed to play the remainder of the game, 


with each player alternately playing and e-mailing the game to his opponent. 


For more details on PBEM, Select "General Help" in the game's Help Menu, 


then Select "1.1.9 Special Menu".


ADVANTAGE: The A/I Selection dialog that appears when a new scenario is 


started allows you to give an advantage to one side or the other. Giving an 


advantage means that combat losses for that side will be reduced below 


normal and combat losses for the other side will be increased above normal. 


Advantage values can range from 0 to 100 for either side. The default value 


of "0" means that neither side gets an advantage. The Set Advantage menu 


item is used to view or change the current Advantage value associated with 


a battle. Advantage values cannot be changed during a modem-play or PBEM 


game, however. 


RECORDING BATTLES: Selecting the "Record Battle" feature of the Special 


menu allows you to record a scenario as you play it. You can then "replay" 


this saved battle later by Selecting "Replay" from the File menu.


	When you Select "Record Battle", a dialog box will appear which 


allows you to name the file. After doing so, Select "OK" - and from this 


point all turns will be saved into this file. At any time during play, you 


can Select "Record Battle" again to turn off this feature.


	When you want to view the replay file, Select "Replay" in the File 


menu. To halt the replay, press the "Esc" key. To resume the replay, Select 


"Restart Replay" in the Special menu. Note that the replay will be from the 


perspective of the other side in the game.


	***IMPORTANT: You cannot record modem-play or PBEM battles. (The 


Record Battle feature operates automatically during PBEM games.)***


Corrected font and icon problems in the scenario editor.


Corrected the number of M7 self-propelled artillery batteries allotted to


U.S. armored divisions by the scenario editor.


VERSION 1.12  4/96


Fixed A/I bug that caused the program to hang when A/I anti-aircraft fire 


was directed at an air unit in the same hex as the firing unit.


To view a unit's description in the Unit Handbook *while* that unit is 


Selected in the main program, Select "Unit Handbook" in the Help Menu (or 


press F2).


VERSION 1.11  3/96


Corrected video display problem.


VERSION 1.1  2/96


NEW MAP: A new Battleview map has been added. In the Display menu it is 


called the "3D Zoom-Out Map", and shows the map at 50% of its normal size.


NEW TOOLBOX BUTTONS: Two new Toolbox buttons have been added.


	The button showing a cross with an arrow at each of its tips hides 


(or displays) the Unit List and Terrain Info Box. When these are hidden, 


more of the map appears in their place. To Select a unit in the current 


Hot Spot hex when the Unit List is hidden, *right-click* on that hex to 


reveal the Pop-Up Selection Dialog, then left-click on the name of the 


desired unit in the dialog (holding down the Shift or Ctrl key while doing 


so will let you Select more than one unit).


	The button with a bulls-eye and a "prohibited" symbol toggles (on 


or off) a display of which hexes can be in the LOS of the current Hot Spot 


hex. An "X" in a hex indicates *no* LOS. Note that this display does *not* 


reflect scenario-specific effects, such as visibility (weather), the 


presence of smoke/wrecks, etc.


NULL MODEM: Null Modem capability has been added to Modem Play. Null-modem 


play requires a direct cable connection between the two computers. Users 


should obtain a suitable serial communication cable and a null-modem 


connector (available at computer supply stores). Note that under null 


modem, the *exact* baud rate for both machines must be Selected. Note 


also that some older machines may not have serial ports that can handle 


speeds at or above 9600 baud, so a lower rate may have to be used.


	To start a scenario using null modem, launch the game by double-


clicking on the " Battleground: Ardennes" program item. Follow the same 


onscreen procedure for starting a normal modem game (see p.39 of the 


Players Guide), but answer "Yes" when the question "Are you using a 


null-modem cable?" appears.


	To start a null-modem scenario via the "Kampfgruppe Peiper", 


"Roadblock at Clervaux" or "Battle for Bastogne" program item, decide 


who will be the Host and who will be the Caller (see the first paragraph 


of 6.1 on p.39 of the Players Guide). Each player then launches the game 


by double-clicking on the program item appropriate for the agreed-upon 


scenario. Once the map appears on his screen, the Host Selects "Modem 


Host", and the Caller Selects "Modem Caller", in the Modem Menu. Both 


players then configure their modem port and baud rate. Upon successful 


connection, the Host selects "New" from the File Menu (if starting a new 


scenario) or "Open" (if resuming a saved battle), and opens the scenario. 


Play then begins.


The modem-play Dial Dialog now "remembers" the previous number dialed.


The modem-play "phantom unit" bug in the Movement Phase and several other 


small bugs have been fixed.


STRENGTH POINTS: Each unit now has a Strength Point (SP) size which has 


an impact on combat, stacking, wreck effects, and the passenger capacity 


of transport vehicles. The unit's SP size appears within a circle in the 


lower left-hand corner of its illustration in the Unit List. Only when a 


unit has been entirely eliminated is it counted as a loss for VP purposes 


(and listed as a loss in the Strength Dialog). 


	COMBAT: In combat, a unit attacks a number of times equal to its 


SP size, and SP-loss results reduce the defender's SP size accordingly. 


(See "NEW CRT" below.)


	STACKING: Maximum stacking per hex is now 24 SP or six units, 


whichever is reached first. Passengers do not count, but wrecks do (see 


next paragraph). If more units than the Unit List can display at one time 


occupy a hex, two small arrows will appear in the lower right-hand corner 


of the screen. Left-clicking on these arrows will scroll the Unit List 


display.


	WRECKS: Each time a hard target loses a SP, it leaves a one-SP 


wreck. Only when the number of wreck SPs in a hex reaches six does the 


wreck affect LOS like smoke. The maximum number of wreck SPs that can 


exist in a hex is 18. A wreck icon with no smoke depiction indicates that 


less than 6 wreck SPs exist in the hex, while an icon with a smoke 


depiction indicates 6-18 wreck SPs. To find the exact number, put the Hot 


Spot in the wreck hex and check the wreck's SP size in the Unit List.


	PASSENGERS: Each "carrier" vehicle unit (i.e., truck, wagon, 


basic halftrack) can carry *one* unit whose SP size is less than or equal 


to the carrier unit's SP size. Each other vehicle type able to transport 


an infantry-type unit can carry *one* such unit whose SP size is less than 


or equal to *twice* that vehicular unit's SP size.


NEW CRT: The Combat Results Table has been changed to incorporate SP losses. 


A positive number indicates a SP loss of that amount, and a "D" indicates a 


Disruption result. However, Disruption results do not automatically cause 


Disruption of the target unit. Instead, the program counts the number of 


Disruption and SP results caused by the attack, then divides that number 


by the SP size of the target to find a percentage chance of actual 


Disruption. Note that the combat results given onscreen are the *net* 


results of the attack. If an attack causes a SP loss *and* Disruption, 


that target also suffers a morale loss of one.


FOG OF WAR: When FOW is in effect for a side, its hidden units will *not* 


automatically be revealed when they are in enemy LOS. The program makes a 


calculation for each hidden unit at the start of the turn, and again at 


the end of the Movement Phase, to find which will remain hidden and which 


are revealed. Generally, infantry and antitank guns are the hardest to 


reveal. In addition, for any two units of the same kind, the one with a 


bigger SP size will be revealed more easily than the other.


ARTILLERY AVAILABILITY: At the beginning of each friendly Player Turn, 


the program makes a die roll for each of the friendly side's Indirect-Fire 


units that fired in the previous turn to see which ones are still 


"available" to fire again. The "Next Phase Report" lists how many are 


"out of ammo" (i.e., not available for the present turn). The artillery-


availability numbers appear in the Terrain Info Box when you right-click in 


it. They are labeled "Ammo", and are given in the form "#/#", with the 


Allied # on the left and the Axis # on the right. Each number represents 


the percentage chance of being able to fire again.


